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Preface

This guide explains how to install Sun StorEdge™ Configuration Service, Sun
StorEdge Diagnostic Reporter, and the Sun StorEdge Command-Line Interface (CLI).

Sun StorEdge Configuration Service enables you to monitor and manage your Sun
StorEdge 3000 family product through a graphical user interface (GUI). For
information about using Sun StorEdge Configuration Service, refer to the Sun
StorEdge 3000 Family Configuration Service User’s Guide.

Sun StorEdge Diagnostic Reporter is a companion utility of Sun StorEdge
Configuration Service that reports your storage system events to specified email
addresses. For information about using Sun StorEdge Diagnostic Reporter, refer to
the Sun StorEdge 3000 Family Diagnostic Reporter User’s Guide.

The CLI enables you to perform many of the same operations as Sun StorEdge
Configuration Service or the firmware application. For information about using the
CLI, refer to the Sun StorEdge 3000 Family CLI User’s Guide.

Unless otherwise specified, the Sun StorEdge 3120 SCSI array, Sun StorEdge 3310
SCSI array, Sun StorEdge 3320 SCSI array, Sun StorEdge 3510 FC array, and Sun
StorEdge 3511 SATA array are referred to as the array or arrays.

This guide is written for experienced system administrators who are familiar with
Sun hardware and software products.
xi



How This Book Is Organized
This book covers the following topics:

Chapter 1 covers information to be aware of before installing Sun StorEdge
Configuration Service, Sun StorEdge Diagnostic Reporter, or the command-line
interface (CLI).

Chapter 2 provides system requirements and installation procedures for Sun
StorEdge Configuration Service agents and consoles, Diagnostic Reporter, and the
CLI on a Solaris™ host.

Chapter 3 provides system requirements and installation procedures for Sun
StorEdge Configuration Service agents and consoles, Diagnostic Reporter, and the
CLI on a Windows host.

Chapter 4 provides system requirements and installation procedures for Sun
StorEdge Configuration Service agents and consoles, Diagnostic Reporter, and the
CLI on a Linux host.

Chapter 5 provides system requirements and installation procedures for Sun
StorEdge Configuration Service agents and consoles, Diagnostic Reporter, and the
CLI on an HP-UX host.

Chapter 6 provides system requirements and installation procedures for Sun
StorEdge Configuration Service agents and consoles, Diagnostic Reporter, and the
CLI on an IBM AIX host.

Chapter 7 provides procedures for installing the Sun StorEdge 3510/3511 SMI-S
Provider.

Using UNIX Commands
This document might not contain information on basic UNIX® commands and
procedures such as shutting down the system, booting the system, and configuring
devices. Refer to the following for this information:

■ Software documentation that you received with your system

■ Solaris™ operating system documentation, which is at

http://docs.sun.com
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Shell Prompts

Typographic Conventions

Shell Prompt

C shell machine-name%

C shell superuser machine-name#

Bourne shell and Korn shell $

Bourne shell and Korn shell superuser #

Typeface1

1 The settings on your browser might differ from these settings.

Meaning Examples

AaBbCc123 The names of commands, files,
and directories; on-screen
computer output

Edit your.login file.
Use ls -a to list all files.
% You have mail.

AaBbCc123 What you type, when contrasted
with on-screen computer output

% su

Password:

AaBbCc123 Book titles, new words or terms,
words to be emphasized.
Replace command-line variables
with real names or values.

Read Chapter 6 in the User’s Guide.
These are called class options.
You must be superuser to do this.
To delete a file, type rm filename.
Preface xiii



Related Documentation
The following table contains a list of related software documentation. For a complete
list of all related documentation, refer to the Sun StorEdge 3000 Family Installation,
Operation, and Service Manual for your array.

Accessing Sun Documentation
All Sun StorEdge 3000 family documentation is available online in both PDF and
HTML format at the following location:

http://www.sun.com/products-n-solutions/hardware/docs/
Network_Storage_Solutions/Workgroup/

You can view, print, or purchase a broad selection of Sun documentation at:

http://www.sun.com/documentation

Title Part Number

Sun StorEdge 3120 SCSI Array Release Notes 816-7955

Sun StorEdge 3310 SCSI Array Release Notes 819-7109

Sun StorEdge 3320 SCSI Array Release Notes 817-7660

Sun StorEdge 3510 FC and 3511 SATA Array Release Notes 817-6597

Sun StorEdge 3000 Family RAID Firmware 4.2x User’s Guide 817-3711

Sun StorEdge 3000 Family Configuration Service 2.5 User’s Guide 817-3337

Sun StorEdge 3000 Family Diagnostic Reporter 2.5 User’s Guide 817-3338

Sun StorEdge 3000 Family CLI 2.5 User’s Guide 817-4951

Sun StorEdge 3000 Family RAID Controller Firmware Migration Guide 819-6573
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Contacting Sun Technical Support
For late-breaking news and troubleshooting tips, review the release notes for your
array, available at the locations shown in “Accessing Sun Documentation” on
page xiv.

If you have technical questions about this product that are not answered in the
documentation, go to:

http://www.sun.com/service/contacting

To initiate or check on a USA-only service request, contact Sun support at:

800-USA4SUN

To obtain international technical support, contact the sales office of each country at:

http://www.sun.com/service/contacting/sales.html

508 Accessibility Features
The Sun StorEdge documentation is available in 508-compliant HTML files that can
be used with assistive technology programs for visually impaired personnel. These
files are provided on the documentation CD for your product as well as on the
websites identified in the previous “Accessing Sun Documentation” section.
Additionally, the software and firmware applications provide keyboard navigation
and shortcuts, which are documented in the user's guides.
Preface xv
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Sun Welcomes Your Comments
Sun is interested in improving its documentation and welcomes your comments and
suggestions. You can submit your comments by going to:

http://www.sun.com/hwdocs/feedback

Please include the title and part number of your document with your feedback: Sun
StorEdge 3000 Family 2.5 Software Installation Guide, part number 817-3764-18.
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CHAPTER 1

Before You Begin

This chapter covers important information you need to be aware of before you
install Sun StorEdge Configuration Service, Sun StorEdge Diagnostic Reporter, and
the Sun StorEdge CLI. Topics covered in this chapter include:

■ “Release Notes” on page 1
■ “Superuser Privileges” on page 1
■ “Operating System Information” on page 2
■ “Upgrading Software – Agent and Console Version Compatibility” on page 3

Release Notes
Be sure to read the release notes for your array to determine whether the operating
systems covered in this guide are supported by your Sun StorEdge family product
and for other supported software information.

Superuser Privileges
You must be superuser (administrator) to install Sun StorEdge Configuration
Service, Sun StorEdge Diagnostic Reporter, and the Sun StorEdge CLI and to run
Sun StorEdge Configuration Service console.
1



Operating System Information
This section covers information about the operating system (OS).

■ For the Sun StorEdge 3310 SCSI array, Sun StorEdge 3320 SCSI array, Sun
StorEdge 3510 FC array, and Sun StorEdge 3511 SATA array, before you install
Sun StorEdge Configuration Service:

■ Install OS updates. To use Sun StorEdge Configuration Service on a Solaris
host, you need to install the most current Sun recommended OS patches and
Java™ runtime environment software patches. For a list of Sun recommended
patches, refer to the release notes for your array.

■ Make sure that the host that the Sun StorEdge Configuration Service agent is
installed on is connected to a channel with a primary ID assigned. Refer to the
Sun StorEdge 3000 Family Installation, Operation, and Service Manual for your
array for controller defaults and initial configuration information.

■ Make sure that the host is connected to the storage and the host recognizes the
storage.

■ For the Sun StorEdge 3310 SCSI array and the Sun StorEdge 3320 SCSI array,
before you install Sun StorEdge Configuration Service on a Solaris host, make
sure the OS can recognize multiple logical unit numbers (LUNs) under the same
ID. You might need to modify /kernel/drv/sd.conf for additional host LUN
assignments. For information on how to modify this file, refer to the Sun StorEdge
3000 Family Installation, Operation, and Service Manual for your SCSI array. If you
make any changes to the sd.conf file, you need to reboot the workstation for the
modifications to take effect.

■ If your OS contains an enterprise management console, you can configure agents
to send trapped events to the console using the Simple Network Management
Protocol (SNMP) service. The SNMP service is included with the OS and is
installed after installing the TCP/IP protocol stack. If you want the hosts on your
network to send SNMP traps to the enterprise management console, refer to the
“Email and SNMP” appendix in the Sun StorEdge 3000 Family Configuration Service
User’s Guide.
2 Sun StorEdge 3000 Family 2.5 Software Installation Guide • July 2009



Upgrading Software – Agent and
Console Version Compatibility
Because the communication protocol changes from version to version, you must
install both the agent and console when upgrading. If different versions of the agent
and console co-exist, Sun StorEdge Configuration Service is not able to discover
previously configured arrays.
Chapter 1 Before You Begin 3
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CHAPTER 2

Installing the Software on a Solaris
Host

The software installation package for a Solaris host includes all the software
components for Sun StorEdge 3000 family arrays. This chapter provides procedures
for installing Sun StorEdge Configuration Service, Sun StorEdge Diagnostic
Reporter, and the Sun StorEdge Command-Line Interface (CLI) on a Solaris host.
Topics covered in this chapter include:

■ “Before Installing” on page 5

■ “System Requirements” on page 6

■ “Installing the Software” on page 7

■ “Manually Stopping and Starting Sun StorEdge Configuration Service and Sun
StorEdge Diagnostic Reporter” on page 12

■ “Users and Passwords” on page 14

■ “Uninstalling the Software” on page 16

■ “Restoring a Configuration” on page 18

■ “Troubleshooting” on page 19

Before Installing
Before installing the programs, take the following steps:

■ Be sure to read the release notes for your array.

■ Install OS updates. To use Sun StorEdge Configuration Service on a Solaris host,
you need to install the most current Sun recommended OS patches and Java
runtime environment software patches for the Solaris 9, and Solaris 10 OS. For a
list of Sun recommended patches, refer to the release notes for your array.
5



System Requirements
This section lists the system requirements for the Solaris host.

■ A web browser is required to view the online help. If you encounter help display
problems, update your browser to a more recent version.

Note – If you manage storage through the web, you will need Firefox 1.x, Netscape
4.79, or Mozilla 2.1, or later versions of these products. Refer to the Sun StorEdge
3000 Family Configuration Service User’s Guide for details on web-based management.

■ TCP/IP-compliant network interface – Each console must have a TCP/IP-
compliant network interface (such as an Ethernet or Token Ring network card, or
a serial line with a modem). Each agent must have a TCP/IP-compliant network
interface and driver set (included with the operating system).

■ Color monitor – The console is best viewed with a monitor resolution of 1024 x
768 pixels with 256 colors.

■ Operating system, memory, and disk space – The following table lists the system
requirements for the Solaris operating system.

Note – For a list of Sun recommended patches, refer to the release notes for your
array.

TABLE 2-1 Solaris System Requirements for Sun StorEdge Configuration Service, Sun
StorEdge Diagnostic Reporter, and Sun StorEdge CLI

Solaris OS Version Memory Disk Space

Solaris 9 and Solaris 10 with
Sun recommended patches
on SPARC platforms.
Solaris 9 (9 04/04) and
Solaris 10 with Sun
recommended patches on
x86 platforms.

128 Mbyte required,
512 Mbyte recommended

40 Mbyte minimum,
100 Mbyte recommended
6 Sun StorEdge 3000 Family 2.5 Software Installation Guide • July 2009



Installing the Software
The software installation package, SUNWsscs, includes the following components:

■ Sun StorEdge Configuration Service agent
■ Sun StorEdge Configuration Service console
■ Sun StorEdge Diagnostic Reporter agent (daemon)
■ Sun StorEdge Diagnostic Reporter Config Tool (UI)
■ Sun StorEdge Command-Line Interface (CLI)

Note – Before installing the software, be sure to read the release notes for your
array.

Note – You must be superuser to install the package and to run the Sun StorEdge
Configuration Service console.

Upgrading Software – Agent and Console Version
Compatibility
Because the communication protocol changes from version to version, you must
install the SUNWsscs package on all systems that manage the storage when
upgrading. If different versions of the agent and console co-exist, Sun StorEdge
Configuration Service is not able to discover previously configured arrays.

Installation Packages
Sun StorEdge Configuration Service, Sun StorEdge Diagnostic Reporter, and the CLI
are included in one installation package, SUNWsscs, that is contained on the Sun
StorEdge 3000 Family Professional Storage Manager CD. If the CD is not available,
you can download the software from the Sun Download Center web site.

Sun StorEdge Configuration Service offers language support for French, Japanese,
Simplified Chinese and Traditional Chinese. TABLE 2-2 specifies which files are
required for each language.
Chapter 2 Installing the Software on a Solaris Host 7



Note – Sun StorEdge Configuration Service offers Korean language support for
documentation only. The software user interface is in English.

Note – Each language requires that the English installation package be installed
first.

If you are installing only the English version of the package, follow only the
instructions for installing the English package. If you are adding language support,
you must install the English version of the package first.

If you are upgrading, you must install the SUNWsscs package on all systems that
manage the storage. If different versions of the agent and console co-exist, Sun
StorEdge Configuration Service is not able to discover previously configured arrays.

Note – Make sure that Java runtime environment software is installed on the
computer or workstation on which you are installing Sun StorEdge Configuration
Service. Solaris 9 and Solaris 10 support Java runtime environment 1.2.2 through 1.5.

▼ To Download the Updated Software From the
Web Site
If the Sun StorEdge 3000 Family Professional Storage Manager CD is not available,
you can download the software from the Sun Download Center web site.

1. If you are upgrading, be sure you uninstall earlier versions of Sun StorEdge
Configuration Service, Sun StorEdge Diagnostic Reporter, and the CLI, including
the agents.

Individual software packages have been replaced by one package, SUNWsscs,
starting with version 2.0. The individual packages must be removed before you can
install SUNWsscs. For details on uninstalling, see “Uninstalling the Software” on
page 16.

2. Go to:

http://www.sun.com/software/download/

TABLE 2-2 Installation Packages for Solaris OS Language Support

English French Japanese Simplified Chinese Traditional Chinese

SUNWsscs SUNWfsscs SUNWjsscs SUNWcsscs SUNWhsscs
8 Sun StorEdge 3000 Family 2.5 Software Installation Guide • July 2009
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3. Under System Administration → Storage Management, click the StorageTek 3000
Family Storage Products - Related Software link.

You are taken to the Sun StorEdge 3000 Family Storage Products - Related Software
page.

4. Click Download.

5. If not previously registered, register.

a. Click the Register Now link at the bottom of the left column.

b. On the registration page, enter applicable data in the required fields and click
Register.

6. Log in.

a. Type your Username and Password in the left column, and click Login.

b. On the Terms of Use page, read the license agreement, click Yes next to Accept,
and click the Continue button.

7. On the software download page, click the link for your array and operating
system.

8. In the dialog box that is displayed, specify a destination directory and save the
file.

9. Change to the directory that the file was downloaded to and unzip the file.

10. Type:

where filename is the name of the file that was downloaded and $ARCH is either
sparc or i386, depending on the Solaris OS platform.

11. Go to and Step 3 in “To Install the Software From the CD” on page 9.

▼ To Install the Software From the CD
1. If you are upgrading, be sure you uninstall earlier versions of Sun StorEdge

Configuration Service, Sun StorEdge Diagnostic Reporter, and the CLI, including
the agents.

Individual software packages have been replaced by one package, SUNWsscs,
starting with version 2.0. The individual packages must be removed before you can
install SUNWsscs. For details on uninstalling, see “Uninstalling the Software” on
page 16.

cd filename/solaris/$ARCH
Chapter 2 Installing the Software on a Solaris Host 9



2. Insert the Sun StorEdge 3000 Family Professional Storage Manager CD and type:

where $ARCH is either sparc or i386, depending on the Solaris OS platform.

3. To install the English package, type:

■ (Optional) To add language support, type:

where x is f, j, c or h, depending on what language you are installing. See
TABLE 2-2 for package names.

4. Provide appropriate responses to each of the installation prompts.

a. If asked if you want to restore the agent configuration, type y. (If you type n,
you will need to re-enable the managing servers.)

b. To continue with the installation, type y and press Return.

After the package is installed, the following message is displayed, indicating it
was installed successfully.

The Sun StorEdge Configuration Service components are installed in the
following directories:

■ /opt/SUNWsscs/ssagent

# cd /cdrom/cdrom0/product/solaris/$ARCH

# pkgadd -d . SUNWsscs

# pkgadd -d . SUNWxsscs

The previous configuration was saved. Do you want to restore the
configuration [y,n,?,q]: y

Do you want to continue with the installation of <SUNWsscs>[y,n,?]
y

Installation of <SUNWsscs> was successful.
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■ /opt/SUNWsscs/sscsconsole

The Sun StorEdge Diagnostic Reporter components are installed in the following
directories:

■ /opt/SUNWsscs/ssdiagreporterd
■ /opt/SUNWsscs/ssdiagreporterui

The CLI is installed in /opt/SUNWsscs/sbin/sccli.

5. If you are using Sun StorEdge Configuration Service and Diagnostic Reporter to
manage and monitor the storage, the following additional steps are required.

a. You must set passwords for all Sun StorEdge Configuration Service users.

See “Users and Passwords” on page 14 for more information.

Note – User passwords are deleted when Sun StorEdge Configuration Service is
uninstalled. You must reenter the ssmon, ssadmin, and ssconfig passwords as
described in “Users and Passwords” on page 14.

b. Before starting the Sun StorEdge Configuration Service console, you must run
the following command to specify the web browser to access online help.

c. The Sun StorEdge Configuration Service agent and the Sun StorEdge
Diagnostic Reporter agent (daemon) have been installed but are not configured
to start at boot time by default. To enable the Sun StorEdge Configuration
Service agent to start automatically when the system boots, and to start it now,
type:.

To enable Sun StorEdge Diagnostic Reporter to start automatically when the
system boots, and to start it now, type:

# /opt/SUNWsscs/sscsconsole/config_sscon

# /etc/init.d/ssagent enable start

# /etc/init.d/ssdgrptd enable start
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6. For Sun StorEdge 3310 SCSI and Sun StorEdge 3320 SCSI arrays, edit
/kernel/drv/sd.conf if LUNs other than LUN 0 are mapped from the array to
the host and an onboard HBA for Sun hosts or third-party HBAs is used for
connecting the device.

Add lines for LUNs as appropriate for your configuration. LUNs can be numbered
from 0-31. Generally, do not add more LUN definitions than you actually plan to
have, since doing so increases the time needed to scan each SCSI bus. For
information on modifying the sd.conf file, refer to the Sun StorEdge 3000 Family
Installation, Operation, and Service Manual for your SCSI array.

7. If the sd.conf file has been edited, perform a reconfiguration reboot.

If the sd.conf file has not been edited, you do not have to perform a
reconfiguration reboot and the agent starts automatically.

▼ To Install a Japanese Version of the Man Page

The CLI for the Solaris host offers a Japanese version of the man page. To install it,
insert the Sun StorEdge 3000 Family Professional Storage Manager CD and type:

Manually Stopping and Starting Sun StorEdge
Configuration Service and Sun StorEdge
Diagnostic Reporter
During installation, you were provided with steps to start the Sun StorEdge
Configuration Service agent and the Sun StorEdge Diagnostic Reporter agent
automatically when the system boots. You can also start and stop the agents
manually.

Note – You must be superuser to start and stop the agent.

If you use start without first using stop, the script restarts any agents that have
stopped. If all the agents have stopped (as with a stop option), the script
reconfigures the runtime environment before restarting the agents.

# pkgadd -d /cdrom/cdrom0/product/solaris SUNWjsccl
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▼ To Stop or Start the Sun StorEdge Configuration
Service Agent
To stop the Sun StorEdge Configuration Service agent, type:

To start the Sun StorEdge Configuration Service agent, type:

▼ To Stop or Start the Sun StorEdge Diagnostic Reporter
Agent

To stop the Sun StorEdge Diagnostic Reporter agent, type:

To start the Sun StorEdge Diagnostic Reporter agent, type:

▼ To Determine Whether Agents are Running

To determine if the agents are running, type:

Both ssmon and ssserver are displayed in the output if the Sun StorEdge
Configuration Service agent is running. If Sun StorEdge Diagnostic Reporter is
running, ssdgrptd is displayed. If you have enabled SNMP trap generation, you
also see the name sstrapd.

# /etc/init.d/ssagent stop

# /etc/init.d/ssagent start

# /etc/init.d/ssdgrptd stop

# /etc/init.d/ssdgrptd start

# ps -e | grep ss
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If the storage system is not being displayed after initial boot, stop the agent, and at
the command prompt, run:

Label the desired disks, and then restart the agent.

Users and Passwords
The following sections explain how to create users and passwords for Sun StorEdge
Configuration Service.

Administrative (User) Security Levels and
Guidelines
If you are running Sun StorEdge Configuration Service on a Solaris host,
administrator security levels are automatically created during the installation process. You
only need to set passwords and assign users according to the desired permission
levels.

Administrative functions require access logins and passwords to prevent the
possibility of one administrator reallocating or removing storage resources
belonging to other clients and hosts without authorization.

You assign separate passwords for the three levels of security for the program. You
do this by setting up three users on the agents that have storage devices that are
managed by the program. These three users are automatically added during the
installation of the agent.

The security levels must have these exact names:

■ ssmon

Represents the monitoring level of the software.

■ ssadmin

Represents the administration level of the software and provides access to the
Rebuild, Parity Check, and Schedule Parity Check functions, as well as
monitoring.

# format
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■ ssconfig

Represents the configuration level of the software and gives the installer direct
access to the configuration functions and all other related aspects of the program.

These login names are required for the three security levels. After installation, you
must assign a password to each security name.

Note – In the event that one of these usernames is already in use, either modify the
existing username, use one of the other Sun StorEdge Configuration Service
usernames, or combine the two roles.

Note – User passwords are deleted when Sun StorEdge Configuration Service is
uninstalled. You must reenter the ssmon, ssadmin, and ssconfig passwords.

The ssmon, ssadmin, and ssconfig names are logins that correspond only to
security levels within the program. For UNIX operating environments, the default
shell for these accounts is assigned to /bin/false to prevent the user IDs from
being used for interactive logins.

You can set up Sun StorEdge Configuration Service so that monitoring does not
require users to type the ssmon password. To do so, select the Auto Discovery
option when the servers are added to the Managed Servers list at the console. You
can set up these three logins and passwords locally on each host. (The accounts can
have different passwords on each host, if desired.)

Once you have set up these three logins on the agents to be managed, the system
administrator typically provides user access to the program by assigning employees
appropriate passwords, which are based on the level of security required to
complete tasks. For example, everyone who has administration privileges on a
particular host is assigned the same password that was established for the user
ssadmin.

Note – To add servers to the Managed Servers list, refer to the Sun StorEdge 3000
Family Configuration Service User’s Guide.
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▼ To Create Passwords and Permissions
Create a password for each of the new users by typing:

You will be prompted to re-enter the password before receiving confirmation.

Administrators might also want to change group permissions, which are defined in
the svrlist.dat file located in the /opt/SUNWsscs/sscsconsole directory
during installation.

The console is a Java technology-based utility, and as such, cannot provide facilities
to control permissions or ownership of files that Sun StorEdge Configuration Service
creates. The svrlist.dat file is easily readable by various forms of ASCII text
processors. It contains the encrypted password for the user ssmon and can be
decrypted.

Note – Do not change the permissions and group ownership of svrlist.dat after
adding all agents that are being monitored.

Uninstalling the Software
Individual software packages have been replaced by one package, SUNWsscs,
starting with version 2.0. The individual packages must be removed before you can
install SUNWsscs. See “To Uninstall Earlier Versions of Sun StorEdge Configuration
Service and Sun StorEdge Diagnostic Reporter” on page 17 and “To Uninstall Earlier
Versions of the Sun StorEdge CLI” on page 17 for more information.

To uninstall version 2.0 or later of the software, see “To Uninstall Version 2.x of the
Software” on page 18.

If you want to uninstall the Japanese version of the man page, see “To Uninstall
Version 2.x of the Software” on page 18.

Note that some files are not removed because they are created after the installation
and are still valid for the upgrade environment.

# passwd user-name
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▼ To Uninstall Earlier Versions of Sun StorEdge
Configuration Service and Sun StorEdge
Diagnostic Reporter
Use the pkgrm command followed by the package you want to uninstall.

Note – If you added French, Japanese, or Simplified Chinese language support, you
must uninstall those packages before uninstalling the English package.

where package-name is the package you are uninstalling. See TABLE 2-3 for a list of
Sun StorEdge Configuration Service and Sun StorEdge Diagnostic Reporter 1.5
package names.

▼ To Uninstall Earlier Versions of the Sun
StorEdge CLI
Use the pkgrm command to uninstall the CLI.

# pkgrm package-name

TABLE 2-3 Sun StorEdge Configuration Service and Sun StorEdge Diagnostic Reporter
1.5 Installation Packages

English French Japanese Simplified
Chinese

Sun StorEdge Configuration Service

Agent SUNWscsd SUNWfscsd SUNWjscsd SUNWcscsd

Console SUNWscsu SUNWfscsu SUNWjscsu SUNWcscsu

Sun StorEdge Diagnostic Reporter

Agent SUNWscsa SUNWfscs SUNWjscs SUNWcscs

Config
Tool (UI)

SUNWscui SUNWfscui SUNWjscui SUNWcscui

# pkgrm SUNWsccli
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▼ To Uninstall Version 2.x of the Software
Use the pkgrm command to uninstall Sun StorEdge Configuration Service, Sun
StorEdge Diagnostic Reporter, and the CLI.

▼ To Uninstall the Japanese Version of the Man
Page
If you installed the Japanese version of the man page, use the pkgrm command to
uninstall it.

Restoring a Configuration
If you reinstall Sun StorEdge Configuration Service, during the installation
procedure you are asked whether you want to restore the configuration. Version 2.0
of the software stores the configuration information in the following file:

■ /var/opt/SUNWsscs/ssagent/ssagent.cfg

Earlier versions of Sun StorEdge Configuration Service store the configuration
information in separate .tar files:

■ /var/opt/SUNWsscs/sscsagt.cfg.tar – Sun StorEdge Configuration Service
agent

■ /var/opt/SUNWsscs/sscscon.cfg.tar – Sun StorEdge Configuration Service
console

■ /var/opt/SUNWsscs/ssdgrptd.cfg.tar – Sun StorEdge Diagnostic Reporter
agent

■ /var/opt/SUNWsscs/ssdgrptui.cfg.tar – Sun StorEdge Diagnostic
Reporter Config Tool (UI)

# pkgrm SUNWsscs

# pkgrm SUNWjsccl
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Note – If you are removing Sun StorEdge Configuration Service permanently, you
might want to manually remove these files; however, if you later reinstall the
program, you will not be able to restore the agent and console configurations.

Troubleshooting
When installing Sun StorEdge Configuration Service, running java -version
might return a pre-1.2.2 software version even if the machine has Java runtime
environment 1.2.2 through 1.5 installed. If this happens, verify that there is a link
from the Java runtime environment software to the latest version.

Check the /usr directory to confirm there is a link to the latest version of the Java
runtime environment by typing:

If the link is not to the latest version listed, type:

where xxx is the latest version of the Java runtime environment software.

# cd /usr
ls | grep java

rm java
ln -s /usr/xxx /usr/java
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CHAPTER 3

Installing the Software on a
Microsoft Windows Host

This chapter provides procedures for installing Sun StorEdge Configuration Service,
Sun StorEdge Diagnostic Reporter, and the Sun StorEdge Command-Line Interface
(CLI) on a 2.5 host. Topics covered in this chapter are as follows:

■ “System Requirements” on page 21
■ “Installing the Software” on page 22
■ “Users and Passwords” on page 29
■ “Uninstalling the Software” on page 31

System Requirements
This section lists the system requirements for a Microsoft Windows host.

■ A web browser is required to view the online help. If you encounter help display
problems, update your browser to a more recent version.

Note – If you manage storage through the web, you will need current or later
versions of Internet Explorer 4.0, Firefox 1.x, Netscape 4.79, or Mozilla 2.1, or later
versions of these products. Refer to the Sun StorEdge 3000 Family Configuration Service
User’s Guide for details on web-based management.

■ TCP/IP-compliant network interface for the console – Each console must have a
TCP/IP-compliant network interface (such as an Ethernet or Token Ring network
card, or a serial line with a modem). Each agent must have a TCP/IP-compliant
network card interface and driver set (included with the operating system).

■ Color monitor – The console is best viewed with a monitor resolution of 1024 x
768 pixels with 256 colors.
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■ Operating system, memory, and disk space – The following table lists the system
requirements for a Microsoft Windows host.

Installing the Software
Sun StorEdge Configuration Service includes the following components:

■ Sun StorEdge Configuration Service agent
■ Sun StorEdge Configuration Service console
■ Sun StorEdge Diagnostic Reporter (optional utility)
■ Sun StorEdge CLI

Note – Before installing Sun StorEdge Configuration Service, be sure to read the
release notes for your array.

Upgrading Software – Agent and Console Version
Compatibility
Because the communication protocol changes from version to version, you must
install both the agent and console when upgrading. If different versions of the agent
and console co-exist, Sun StorEdge Configuration Service is not able to discover
previously configured arrays.

TABLE 3-1 Windows System Requirements for Sun StorEdge Configuration Service, Sun
StorEdge Diagnostic Reporter, and Sun StorEdge CLI

Microsoft Windows OS Version Memory Disk Space

Windows 2003 256 Mbyte minimum, 512
Mbyte or more recommended.
Requirement is determined by
other large application
programs, such as databases.

40 Mbyte minimum,
400 Mbyte recommended
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Installation Packages
Sun StorEdge Configuration Service, Sun StorEdge Diagnostic Reporter, and the CLI
are included in one installer program. The installation package, setup.exe, is
contained on the Sun StorEdge 3000 Family Professional Storage Manager CD. See
“Installing the Software From the CD” on page 24 or continue with the steps below
to download the software from the Sun Download Center web site.

▼ To Download the Updated Software From the
Web Site
If the Sun StorEdge 3000 Family Professional Storage Manager CD is not available,
you can download the software from the Sun Download Center web site.

1. Go to:

http://www.sun.com/software/download/

2. Under System Administration → Storage Management, click the StorageTek 3000
Family Storage Products - Related Software link.

You are taken to the Sun StorEdge 3000 Family Storage Products - Related Software
page.

3. Click Download.

4. If not previously registered, register.

a. Click the Register Now link at the bottom of the left column.

b. On the registration page, enter applicable data in the required fields and click
Register.

5. Log in.

a. Type your Username and Password in the left column, and click Login.

b. On the Terms of Use page, read the license agreement, click Yes next to Accept,
and click the Continue button.

6. On the software download page, click the link for your array and operating
system.

7. In the dialog box that is displayed, specify a destination directory and save the
file.

8. Change to the directory to which the file was downloaded and unzip the file.
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9. Go to filename\windows, where filename is the name of the file that was
downloaded.

10. Continue with the appropriate installation procedure as described below.

Installing the Software From the CD
You need to install the agent on every Windows host whose storage you want Sun
StorEdge Configuration Service to manage. Install the console on the computer or
workstation you plan to use for managing and maintaining the system storage.

If you are upgrading, you must install both the agent and console. If different
versions of the agent and console co-exist, Sun StorEdge Configuration Service is not
able to discover previously configured arrays.

Note – You must have administrator privileges to install Sun StorEdge
Configuration Service and run the console.

Note – Make sure that Sun Java runtime environment software is installed on the
computer or workstation on which you are installing the console. The earliest release
of Sun Java runtime environment software that is compatible with Sun StorEdge
Configuration Service is 1.2.2.

To install the Sun StorEdge Configuration Service agent, see “To Install the Sun
StorEdge Configuration Service Agent” on page 25. To install the Sun StorEdge
Configuration Service console, see “To Install the Sun StorEdge Configuration
Service Console” on page 26. To install Sun StorEdge Diagnostic Reporter, see “To
Install Sun StorEdge Diagnostic Reporter” on page 27. To install the Sun StorEdge
CLI, see “To Install the Sun StorEdge CLI” on page 28.
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▼ To Install the Sun StorEdge Configuration
Service Agent

1. To make sure the software installation utility functions optimally, close all open
applications.

2. If you are upgrading, be sure you uninstall earlier versions of Sun StorEdge
Configuration Service, Sun StorEdge Diagnostic Reporter, and the CLI, including
the agents.

See “Uninstalling the Software” on page 31.

3. If you are installing the software from the web site, follow Step 1 through Step 8
in “To Download the Updated Software From the Web Site” on page 23, and then
go to Step 5.

4. If you are installing the software from the CD, insert the Sun StorEdge 3000
Family Professional Storage Manager CD and change to the \product\windows
directory.

5. Double-click setup.exe and from the InstallShield Wizard window, click Next.

6. From the Select Component window, select Sun StorEdge Configuration
Service Agent.

7. Click Next.

8. From the Copyright Notice window, read the copyright notice and then click Yes.

9. From the Choose Destination Location window, install to the default folder and
click Next.

The agent is installed in C:\Program Files\Sun\ssagent. To install to a
different folder, click Browse, select another folder, and click Next.

10. From the InstallShield Wizard Complete window, click Finish.

11. From the Select Component window, select another component to install or close
the window.

After the installation is complete, the agent starts automatically.
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▼ To Install the Sun StorEdge Configuration
Service Console

1. To make sure the software installation utility functions optimally, close all open
applications.

2. If you are upgrading, be sure you uninstall earlier versions of Sun StorEdge
Configuration Service, Sun StorEdge Diagnostic Reporter, and the CLI, including
the agents.

See “Uninstalling the Software” on page 31.

3. If you are installing the software from the web site, follow Step 1 through Step 8
in “To Download the Updated Software From the Web Site” on page 23, and then
go to Step 5.

4. If you are installing the software from the CD, insert the Sun StorEdge 3000
Family Professional Storage Manager CD and change to the \product\windows
directory.

5. Double-click setup.exe and from the InstallShield Wizard window, click Next.

6. From the Select Component window, select Sun StorEdge Configuration
Service Console.

7. Click Next.

8. From the Copyright Notice window, read the copyright notice and then click Yes.

9. From the Choose Destination Location window, install to the default folder and
click Next.

The console is installed in C:\Program Files\Sun\sscs. To install to a different
folder, click Browse, select another folder, and click Next.

10. From the Start Copying Files window, select Next.

11. From the InstallShield Wizard Complete window, click Finish.

12. From the Select Component window, select another component to install or close
the window.
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▼ To Install Sun StorEdge Diagnostic Reporter

Note – You must install the Sun StorEdge Configuration Service agent before
installing the Sun StorEdge Diagnostic Reporter agent and Config Tool.

1. To make sure the software installation utility functions optimally, close all open
applications.

2. If you are installing the software from the web site, follow Step 1 through Step 8
in “To Download the Updated Software From the Web Site” on page 23, and then
go to Step 4.

3. If you are installing the software from the CD, insert the Sun StorEdge 3000
Family Professional Storage Manager CD and change to the \product\windows
directory.

4. Double-click setup.exe and from the InstallShield Wizard window, click Next.

5. Select Sun StorEdge Diagnostic Reporter.

6. Click Next.

7. From the Copyright Notice window, click Yes.

8. From the Choose Destination Location window, install to the default folder,
C:\Program Files\Sun\ssdgrpt, and click Next.

To install to a different folder, click Browse, select another folder, and click Next.

9. When the next window is displayed, click Full Installation and click Next.

■ Full Installation – Installs all three software components (Service, Config Tool,
and Mail Receiver Tool)

■ Service Installation – Installs only the background Service software; note that the
Service function can be configured remotely from the Config Tool

■ UI Installation – Installs only the Config and Mail Receiver Tools (not the Service)

Note – If you are not the administrator or you did not install Java runtime
environment software, error messages that the Sun StorEdge Diagnostic Reporter
Service is not running or is failing are displayed and you are unable to complete
installation.

10. From the InstallShield Wizard Complete window, click Finish.

11. From the Select Component window, select another component to install or close
the window.

After the installation is complete, the Diagnostic Reporter agent starts automatically.
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▼ To Install the Sun StorEdge CLI
1. To make sure the software installation utility functions optimally, close all open

applications.

2. If you are installing the software from the web site, follow Step 1 through Step 8
in “To Download the Updated Software From the Web Site” on page 23, and then
continue with Step 4.

3. If you are installing the software from the CD, insert the Sun StorEdge 3000
Family Professional Storage Manager CD and change to the \product\windows
directory.

4. Double-click setup.exe and from the InstallShield Wizard window, click Next.

5. Select Sun StorEdge Command Line Interface.

6. Click Next.

7. From the Copyright Notice window, click Yes.

8. From the Choose Destination Location window, install to the default folder,
C:\Program Files\Sun\sccli, and click Next.

To install to a different folder, click Browse, select another folder, and click Next.

9. From the Select Program Folder window, click Next.

10. From the InstallShield Wizard Complete window, click Finish.

11. From the Select Component window, select another component to install or close
the window.

▼ To Stop or Start the Sun StorEdge Configuration
Service Agent

1. On a Windows 2000 host, choose Start → Programs → Administrative Tools →
Computer Management.

On a Windows 2003 host, choose Start → Administrative Tools → Computer
Management.

Alternatively, you can right-click My Computer and select Manage.

2. Click Services & Applications.

3. Right-click the service (SUNWscsd Monitor, SUNWscsd Server, SUNWscsd
Startup) you want to start or stop.
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▼ To Stop or Start Sun StorEdge Diagnostic
Reporter

1. On a Windows 2000 host, choose Start → Programs → Administrative Tools →
Computer Management.

On a Windows 2003 host, choose Start → Administrative Tools → Computer
Management.

Alternatively, you can right-click My Computer and select Manage.

2. Click Services & Applications.

3. Select the Sun StorEdge Diagnostic Reporter Server, and right-click the service
you want to start or stop.

Users and Passwords
The following sections explain how to create users and passwords.

Administrative (User) Security Levels and
Guidelines
Administrative functions require access logins and passwords to prevent the
possibility of one administrator reallocating or removing storage resources
belonging to other clients and hosts without authorization.

You assign separate passwords for the three levels of security. You do this by setting
up three users on the agents that have storage devices that are managed by the
program.

The security levels must have these exact names:

■ ssmon

Represents the monitoring level of the software.

■ ssadmin

Represents the administration level of the software and provides access to the
Rebuild, Parity Check, and Schedule Parity Check functions, as well as
monitoring.
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■ ssconfig

Represents the configuration level of the software and gives the installer direct
access to the configuration functions and all other related aspects of the program.

These names are required for the three security levels. After installation, you must
assign a password to each security name.

Note – In the event that one of these usernames is already in use, either modify the
existing username, use one of the other Sun StorEdge Configuration Service
usernames, or combine the two roles.

The ssmon, ssadmin, and ssconfig names are logins that correspond only to
security levels within the program.

You can set up Sun StorEdge Configuration Service so that monitoring does not
require users to enter the ssmon password. To do so, select the Auto Discovery
option when the hosts are added to the Managed Servers list at the console. You can
set up these three logins and passwords locally on each host. (The accounts can have
different passwords on each host.)

Once you have set up these three logins on the agents to be managed, the system
administrator then typically provides user access to the program by assigning
employees appropriate passwords, which are based on the level of security required
to complete tasks. For example, everyone who has administration privileges on a
particular host would be assigned the same password that was established for the
user ssadmin.

Note – To add servers to the Managed Servers list, refer to the Sun StorEdge 3000
Family Configuration Service User’s Guide.

Global Passwords
If you have a large network and do not want to set up logins individually, and it is
acceptable to have the same passwords on multiple hosts, you can establish the three
logins on a domain server under Microsoft Windows. As a result, all other servers
within the Microsoft Windows domain can access the three logins along with their
respective passwords.
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▼ To Create Windows Users
1. On a Windows 2000 host, choose Start → Settings → Control Panel →

Administrative Tools → Computer Management → System Tools → Local Users and
Groups.

On a Windows 2003 host, choose Start → Administrative Tools → Computer
Management → Local Users and Groups.

2. Right-click the Users folder and choose New User to add the three users (ssmon,
ssconfig, and ssadmin).

3. Add one of the users under User name. If desired, enter a description under
Description.

4. Enter a password and, if desired, select User Cannot Change Password and
Password Never Expires.

Uninstalling the Software
Use the Windows Add/Remove Programs utility to remove Sun StorEdge
Configuration Service, Sun StorEdge Diagnostic Reporter, and Sun StorEdge
Command-Line Interface from a Microsoft Windows console.

▼ To Uninstall Sun StorEdge Configuration Service
1. Choose Start → Settings → Control Panel → Add/Remove Programs.

For Windows 2003, choose Start → Control Panel → Add/Remove Programs.

2. Choose Sun StorEdge Configuration Service Agent and choose
Change /Remove.

Respond appropriately to the prompts.

3. Choose Sun StorEdge Configuration Service Console and select
Change/Remove.

Respond appropriately to the prompts.
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▼ To Uninstall Sun StorEdge Diagnostic Reporter
Use the Windows Add/Remove Programs utility to remove Sun StorEdge
Diagnostic Reporter.

1. On a Windows 2000 host, choose Start → Settings → Control Panel → Add/Remove
Programs.

On a Windows 2003 host, choose Start → Control Panel → Add/Remove Programs.

2. Select Sun StorEdge Diagnostic Reporter and select Change/Remove.

Respond appropriately to the prompts.

▼ To Uninstall the Sun StorEdge CLI
Use the Microsoft Windows Add/Remove Programs utility to remove the CLI.

1. For Windows 2000, choose Start → Settings → Control Panel → Add/Remove
Programs.

For Windows 2003, choose Start → Control Panel → Add/Remove Programs.

2. Select Sun StorEdge 3000 Family CLI and select Change/Remove.

Respond appropriately to the prompts.
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CHAPTER 4

Installing the Software on a Linux
Host

This chapter provides procedures for installing Sun StorEdge Configuration Service,
Sun StorEdge Diagnostic Reporter, and the Sun StorEdge Command-Line Interface
(CLI) on a Sun Linux or Red Hat Linux host. Topics covered in this chapter are as
follows:

■ “System Requirements” on page 33
■ “Installing the Software” on page 34
■ “Users and Passwords” on page 42
■ “Uninstalling the Software” on page 44
■ “Troubleshooting” on page 45

System Requirements
This section lists the system requirements for the Linux host.

■ A web browser is required to view the online help. If you encounter help display
problems, update your browser to a more recent version.

■ TCP/IP-compliant network interface – Each console must have a TCP/IP-
compliant network interface (such as an Ethernet or Token Ring network card, or
a serial line with a modem). Each agent must have a TCP/IP-compliant network
interface and driver set (included with the operating system).

■ Color monitor – The console is best viewed with a monitor resolution of 1024 x
768 pixels with 256 colors.

■ Operating system, memory, and disk space – The following table lists the system
requirements for the Linux operating system.
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Installing the Software
Sun StorEdge Configuration Service software includes the following components:

■ Sun StorEdge Configuration Service agent
■ Sun StorEdge Configuration Service console
■ Sun StorEdge Diagnostic Reporter (optional utility)
■ Sun StorEdge CLI

Note – Before installing Sun StorEdge Configuration Service, be sure to read the
release notes for your array.

Note – You must be superuser to install Sun StorEdge Configuration Service and
run the console.

Upgrading Software – Agent and Console Version
Compatibility
Because the communication protocol changes from version to version, you must
install both the agent and console when upgrading. If different versions of the agent
and console co-exist, Sun StorEdge Configuration Service is not able to discover
previously configured arrays.

TABLE 4-1 Linux System Requirements for Sun StorEdge Configuration Service, Sun
StorEdge Diagnostic Reporter, and Sun StorEdge CLI

Linux OS Version Memory Disk Space

Sun Linux 5.0 on a Sun™ LX50
server (SCSI only)
Red Hat Advanced Server 3.0
SUSE Linux Enterprise Server 9.0
(32-bit and 64-bit)

256 Mbyte minimum,
512 Mbyte recommended

40 Mbyte minimum,
100 Mbyte recommended
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Installation Packages
The installation packages are contained on the Sun StorEdge 3000 Family
Professional Storage Manager CD, and include the following files:

■ SUNWscsd.rpm – Sun StorEdge Configuration Service agent
■ SUNWscsu.rpm – Sun StorEdge Configuration Service console
■ SUNWscsa.rpm – Sun StorEdge Diagnostic Reporter agent
■ SUNWscui.rpm – Sun StorEdge Diagnostic Reporter Config Tool (UI)
■ SUNWsccli.rpm – Sun StorEdge CLI

See “To Download the Updated Software From the Web Site” on page 36 for steps on
how to download the software from the Sun Download Center web site.

Install the agent on each host that is part of Sun StorEdge Configuration Service.
Install the console on the computer or workstation you plan to use for managing and
maintaining the storage system.

The console can be installed on the host or on any client system. The agent must be
installed on the host to which the storage is attached.

Complete the following steps to install the agent, console, or both. You must install
at least one agent and one console for the program to run.

If you are upgrading, you must install both the agent and console. If different
versions of the agent and console co-exist, Sun StorEdge Configuration Service is not
able to discover previously configured arrays.

Note – Make sure that Java runtime environment software is installed on the
computer or workstation on which you are installing Sun StorEdge Configuration
Service. The earliest release of the Java runtime environment software that is
compatible with Sun StorEdge Configuration Service is 1.2.2.

Note – Sun StorEdge Configuration Service requires the gettext package from the
Linux distribution. Make sure that gettext is installed on the computer or
workstation on which you are installing Sun StorEdge Configuration Service.

For more information on gettext, see the following link:

http://www.gnu.org/software/gettext/

If you don’t have a Linux CD, you can download gettext from the following FTP
site:

ftp://ftp.gnu.org/gnu/gettext/
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▼ To Download the Updated Software From the
Web Site
If the Sun StorEdge 3000 Family Professional Storage Manager CD is not available,
you can download the software from the Sun Download Center web site.

1. Go to:

http://www.sun.com/software/download/

2. Under System Administration → Storage Management, click the StorageTek 3000
Family Storage Products - Related Software link.

You are taken to the Sun StorEdge 3000 Family Storage Products - Related Software
page.

3. Click Download.

4. If not previously registered, register.

a. Click the Register Now link at the bottom of the left column.

b. On the registration page, enter applicable data in the required fields and click
Register.

5. Log in.

a. Type your Username and Password in the left column, and click Login.

b. On the Terms of Use page, read the license agreement, click Yes next to Accept,
and click the Continue button.

6. On the software download page, click the link for your array and operating
system.

7. In the dialog box that is displayed, specify a destination directory and save the
file.

8. Change to the directory that the file was downloaded to and unzip the file.

9. Type:

where filename is the name of the file that was downloaded.

10. Go to Step 5 in “To Install Sun StorEdge Configuration Service Agent and Console
From the CD” on page 37.

cd filename/linux
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▼ To Install Sun StorEdge Configuration Service
Agent and Console From the CD

1. If gettext is not installed on the computer or workstation on which you are
installing Sun StorEdge Configuration Service, install it now.

To check to see if gettext is installed, type:

2. If Java runtime environment software is not installed on the computer or
workstation on which you are installing Sun StorEdge Configuration Service,
install it now.

To check the Java runtime environment software version, type:

3. Mount the CD on your file system if it is not already mounted.

4. Insert the Sun StorEdge 3000 Family Professional Storage Manager CD and type:

5. Install the packages in one of the following ways:

■ To install only the agent, type:

■ To install only the console, type:

# rpm -qa | grep gettext

# java -version

# cd mount /dev/cdrom /mnt/cdrom

# cd /mnt/cdrom/product/linux

# rpm -ivh SUNWscsd.rpm

# rpm -ivh SUNWscsu.rpm
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Note – The installation program checks that Java runtime 1.2.2 or later is installed.
If it cannot find it, you are asked to specify the path. If you know that Java runtime
environment 1.2.2 or later has been installed but the installation program cannot find
it, check the /usr directory to confirm that there is a link from Java to the latest
version instead of Java 1.1. For instructions on creating the link, see
“Troubleshooting” on page 45.

6. To access online help, install Netscape Navigator on the system on which you are
installing the console.

Versions earlier than 4.0 are not supported. If Netscape Navigator is not detected,
you are asked to specify the path.

a. Change to /opt/SUNWsscs/sscsconsole and type:

b. Type the absolute path to the web browser.

Note – You can configure the web browser path name at any time; however, if you
do not specify a path name at some point, you cannot access online help.

After the agent is installed, the following message is displayed, indicating the
components were installed successfully and have started:

After the console is installed, the following message is displayed, indicating the
components were installed successfully and have started:

# ./config_sscon

# rpm -ivh SUNWscsd.rpm Preparing...
########################################### [100%] 1:SUNWscsd
########################################### [100%] add user ssmon
add user ssadmin add user ssconfig Configuring and starting Sun
StorEdge(tm) Configuration Service daemons[ OK ]
Starting Sun StorEdge(tm) Configuration Service agent daemon[ OK ]
Starting Sun StorEdge(tm) Configuration Service agent monitor
daemon[ OK ]

# rpm -ivh SUNWscsu.rpm Preparing...
########################################### [100%] 1:SUNWscsu
########################################### [100%]
Installation completed successfully!
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The agent and console are installed in/opt/SUNWsscs/sscsconsole.

▼ To Install Sun StorEdge Diagnostic Reporter

Note – You must install the Sun StorEdge Configuration Service agent before
installing the Sun StorEdge Diagnostic Reporter agent and Config Tool.

1. If you are installing the software from the web site, follow Step 1 through Step 9
in “To Download the Updated Software From the Web Site” on page 36, and then
go to Step 3.

2. If you are installing the software from the CD, insert the Sun StorEdge 3000
Family Professional Storage Manager CD, and type:

3. To install the agent, type:

4. To install the Config Tool (UI), type:

5. When the installation procedure is complete, the agent starts automatically.

The agent is installed in /opt/SUNWsscs/ssdiagreporterd. The Config Tool is
installed in /opt/SUNWsscs/ssdiagreporterui.

▼ To Install the Sun StorEdge CLI
The CLI enables you to perform many of the same operations you perform by
choosing menu options from the firmware application or Sun StorEdge
Configuration Service. The CLI commands have the advantage of being scriptable,
which is especially useful in large data center environments with many arrays that
need to be configured similarly. The package must be installed on a host that is
attached to the array.

# cd /cdrom/cdrom0/product/linux

# rpm -ivh SUNWscsa.rpm

# rpm -ivh SUNWscui.rpm
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Note – Make sure that a logical drive is mapped to the primary controller.

Note – You must be superuser to install the CLI.

1. Mount the CD drive on your file system if it is not already mounted.

2. If you are installing the software from the web site, follow Step 1 through Step 9
in “To Download the Updated Software From the Web Site” on page 36, and then
go to Step 4.

3. If you are installing the software from the CD, insert the Sun StorEdge 3000
Family Professional Storage Manager CD, and type:

4. Type:

To access the CLI, log in as root on the host on which you installed the CLI (and
that is attached to the array), and type:

For a list of options and subcommands, see the man page.

The CLI is installed in /opt/SUNWsscs/sbin/sccli.

# mount /dev/cdrom /mnt/cdrom

# cd /mnt/cdrom/product/linux

# rpm -ivh SUNWsccli.rpm

# sccli (with options and subcommands)
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▼ To Stop or Start the Agents
The Sun StorEdge Configuration Service and Sun StorEdge Diagnostic Reporter
agents can be stopped or started manually by using the run commands scripts.

Note – You must be superuser to start the agents.

If you use start without first using stop, the script restarts any agents that have
stopped. If all the agents have stopped (as with a stop option), the script
reconfigures the runtime environment before restarting the agents.

▼ To Stop or Start the Sun StorEdge Configuration Service
Agent

To stop the Sun StorEdge Configuration Service agent, type:

To start the Sun StorEdge Configuration Service agent, type:

or

▼ To Stop or Start the Sun StorEdge Diagnostic Reporter
Agent

To stop the Sun StorEdge Diagnostic Reporter agent, type:

To start the Sun StorEdge Diagnostic Reporter agent, type:

# /etc/init.d/ssagent stop

# /etc/init.d/ssagent start

# service ssagent start

# /etc/init.d/ssdgrptd stop

# /etc/init.d/ssdgrptd start
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▼ To Determine Whether Agents are Running

To determine if the agents are running, type:

Both ssmon and ssserver are displayed in the output if the Sun StorEdge
Configuration Service agent is running. If Sun StorEdge Diagnostic Reporter is
running, ssdgrptd is displayed. If you have enabled SNMP trap generation, you
also see the name sstrapd.

Users and Passwords
The following sections explain how to create users and passwords.

Administrative (User) Security Levels and
Guidelines
If you are running the program on a Linux host, administrator security levels are
automatically created during the installation process. You only need to set passwords and
assign users according to the desired permission level.

Administrative functions require access logins and passwords to prevent the
possibility of one administrator reallocating or removing storage resources
belonging to other clients and hosts without authorization.

You assign separate passwords for the three levels of security for the program. You
do this by setting up three users on the agents that have storage devices that are
managed by the program. These three users are automatically added during the
installation of the agent.

The security levels must have these exact names:

■ ssmon

Represents the monitoring level of the software.

■ ssadmin

Represents the administration level of the software and provides access to the
Rebuild, Parity Check, and Schedule Parity Check functions, as well as
monitoring.

# ps -e | grep ss
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■ ssconfig

Represents the configuration level of the software and gives the installer direct
access to the configuration functions and all other related aspects of the program.

These names are required for the three security levels. After installation, you must
assign a password to each security name.

Note – User passwords are deleted when Sun StorEdge Configuration Service is
uninstalled. If you had a previous configuration, you have to reenter the ssmon,
ssadmin, and ssconfig passwords.

Note – In the event that one of these usernames is already in use, either modify the
existing username, use one of the other Sun StorEdge Configuration Service
usernames, or combine the two roles.

The ssmon, ssadmin, and ssconfig names are logins that correspond only to
security levels within the program. For UNIX operating environments, the default
shell for these accounts is assigned to /bin/false to prevent the user IDs from
being used for interactive logins.

You can set up Sun StorEdge Configuration Service so that monitoring does not
require users to type the ssmon password. To do so, select the Auto Discovery
option when the hosts are added to the Managed Servers list at the console. You can
set up these three logins and passwords locally on each host. (The accounts can have
different passwords on each host, if desired.)

Once you have set up these three logins on the agents to be managed, the system
administrator typically provides user access to the program by assigning employees
appropriate passwords, which are based on the level of security required to
complete tasks. For example, everyone who has administration privileges on a
particular host is assigned the same password that was established for the user
ssadmin.

Note – To add servers to the Managed Servers list, refer to the Sun StorEdge 3000
Family Configuration Service User’s Guide.
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▼ To Create Passwords and Permissions
Create a password for each of the new users by typing:

You will be prompted to re-enter the password before receiving confirmation.

Administrators might also want to change group permissions, which are defined in
the svrlist.dat file located in the /opt/SUNWsscs/sscsconsole directory
during installation.

The console is a Java technology-based utility, and as such, cannot provide facilities
to control permissions or ownership of files that Sun StorEdge Configuration Service
creates. The svrlist.dat file is easily readable by various forms of ASCII text
processors. It contains the encrypted password for the user ssmon and can be
decrypted.

Note – Do not change the permissions and group ownership of svrlist.dat after
adding all agents that are being monitored.

Uninstalling the Software
You must uninstall all components of Sun StorEdge Configuration Service when
upgrading to a newer version of the software. Note that some files are not removed
because they are created after the installation and are still valid for the upgrade
environment.

▼ To Uninstall Sun StorEdge Configuration Service
Use the rpm -e command followed by the package you want to uninstall ,
SUNWscsd (agent) or SUNWscsu (console).

# passwd user-name

# rpm -e SUNWscsd
# rpm -e SUNWscsu
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▼ To Uninstall Sun StorEdge Diagnostic Reporter
Use the rpm -e command followed by the package you want to uninstall,
SUNWscsa (agent) or SUNWscui (Config Tool).

▼ To Uninstall the Sun StorEdge CLI
Use the rpm -e command to uninstall the CLI.

Troubleshooting
When installing Sun StorEdge Configuration Service, running java -version
might return a pre 1.2.2 software version even if the machine has Java runtime
environment 1.2.2 or higher installed. If this happens, confirm that there is a link
from Java runtime environment software to the latest version.

1. Check the /usr directory to confirm there is a link to the latest version of the Java
runtime environment by typing:

2. If the link is not to the latest version listed, type:

where xxx is the latest version of the Java runtime environment software.

# rpm -e SUNWscsa
# rpm -e SUNWscui

# rpm -e SUNWsccli

# cd /usr
# ls | grep java

# rm java
# ln -s /usr/xxx /usr/java
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CHAPTER 5

Installing the Software on an HP-UX
Host

This chapter provides procedures for installing Sun StorEdge Configuration Service,
Sun StorEdge Diagnostic Reporter, and the Sun StorEdge Command-Line Interface
(CLI) on an HP-UX host. Topics covered in this chapter are as follows:

■ “System Requirements” on page 47
■ “Installing the Software” on page 48
■ “Users and Passwords” on page 56
■ “Uninstalling the Software” on page 58

System Requirements
This section lists the system requirements for the HP-UX host.

■ A web browser is required to view the online help. If you encounter help display
problems, update your browser to a more recent version.

Note – If you manage storage through the web, you will need Firefox 1.x, Netscape
4.79, or Mozilla 2.1, or later versions of these products. Refer to the Sun StorEdge
3000 Family Configuration Service User’s Guide for details on web-based management.

■ TCP/IP compliant network interface – Each console must have a TCP/IP-
compliant network interface (such as an Ethernet or Token Ring network card, or
a serial line with a modem). Each agent must have a TCP/IP capable network
card interface and driver set (included with the operating system).

■ Color monitor – The console is best viewed with a monitor resolution of 1024 x
768 pixels with 256 colors.
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■ Operating system, memory, and disk space – The following table lists the system
requirements for an HP-UX host.

Installing the Software
Sun StorEdge Configuration Service software includes the following components:

■ Sun StorEdge Configuration Service agent
■ Sun StorEdge Configuration Service console
■ Sun StorEdge Diagnostic Reporter (optional utility)
■ Sun StorEdge CLI

Note – Before installing Sun StorEdge Configuration Service, be sure to read the
release notes for your array.

Note – You must be superuser to install Sun StorEdge Configuration Service and
run the console.

Upgrading Software – Agent and Console Version
Compatibility
Because the communication protocol changes from version to version, you must
install both the agent and console when upgrading. If different versions of the agent
and console co-exist, Sun StorEdge Configuration Service is not able to discover
previously configured arrays.

TABLE 5-1 HP-UX System Requirements for Sun StorEdge Configuration Service, Sun
StorEdge Diagnostic Reporter, and Sun StorEdge CLI

HP-UX OS Version Memory Disk Space

11.0 and 11i 128 Mbyte minimum,
512 Mbyte recommended

40 Mbyte minimum,
100 Mbyte recommended
48 Sun StorEdge 3000 Family 2.5 Software Installation Guide • July 2009



Installation Packages
The installation packages are contained on the Sun StorEdge 3000 Family
Professional Storage Manager CD, and include the following files:

■ SUNWscsd.depot – Sun StorEdge Configuration Service agent
■ SUNWscsu.depot – Sun StorEdge Configuration Service console
■ SUNWscsa.depot – Sun StorEdge Diagnostic Reporter agent
■ SUNWscui.depot – Sun StorEdge Diagnostic Reporter Config Tool (UI)
■ SUNWsccli.depot – Sun StorEdge CLI

See “To Download and Install the Updated Software From the Web Site” on page 49
for steps on how to download the software from the Sun Download Center web site.

Install the agent on each host that is part of Sun StorEdge Configuration Service.
Install the console on the computer or workstation you plan to use for managing and
maintaining the storage system.

The console can be installed on the host or on any client system. The agent must be
installed on the host to which the storage is attached.

Complete the following steps to install the agent, console, or both. You must install
at least one agent and one console for the program to run.

If you are upgrading, you must install both the agent and console. If different
versions of the agent and console co-exist, Sun StorEdge Configuration Service is not
able to discover previously configured arrays.

Note – Sun StorEdge Configuration Service on HP-UX supports Java runtime
environment 1.2.2 through 1.5. Make sure that a compatible version of Java runtime
environment is installed on the remote login host. If you are not using a remote login
host environment, it must be installed on the HP-UX machine on which you are
installing Sun StorEdge Configuration Service.

▼ To Download and Install the Updated Software
From the Web Site
If the Sun StorEdge 3000 Family Professional Storage Manager CD is not available,
you can download the software from the Sun Download Center web site.

1. Go to:

http://www.sun.com/software/download/
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2. Under System Administration → Storage Management, click the StorageTek 3000
Family Storage Products - Related Software link.

You are taken to the Sun StorEdge 3000 Family Storage Products - Related Software
page.

3. Click Download.

4. If not previously registered, register.

a. Click the Register Now link at the bottom of the left column.

b. On the registration page, enter applicable data in the required fields and click
Register.

5. Log in.

a. Type your Username and Password in the left column, and click Login.

b. On the Terms of Use page, read the license agreement, click Yes next to Accept,
and click the Continue button.

6. On the software download page, click the link for your array and operating
system.

7. In the dialog box that is displayed, specify a destination directory and save the
file.

8. Change to the directory that the file was downloaded to and unzip the file.

9. Type:

where filename is the name of the file that was downloaded.

10. To install the Sun StorEdge Configuration Service agent, type:

11. To install the Sun StorEdge Configuration Service console, type:

The agent is installed in /opt/SUNWsscs/ssagent. The console is installed in
/opt/SUNWsscs/sscsconsole.

cd filename /hpux

# swinstall -s SUNWscsd.depot

# swinstall -s SUNWscsu.depot
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▼ To Install the Sun StorEdge Configuration
Service Agent and Console From the CD

1. If Java runtime environment software is not installed on the computer or
workstation on which you are installing Sun StorEdge Configuration Service,
install it now.

To check the Java runtime environment software version, type:

2. Make sure that a mounting point has been created for the CD.

3. Insert the Sun StorEdge 3000 Family Professional Storage Manager CD.

4. Determine the device entry for the CD:

Note the device entry, for example:

5. Mount the CD on your file system if it is not already mounted:

6. To install the agent, type:

7. To install the console, type:

The agent is installed in /opt/SUNWsscs/ssagent. The console is installed in
/opt/SUNWsscs/sscsconsole.

# java -version

# ioscan -fnC disk

/dev/dsk/c2t5d0

# mount -r device entry mounting point

# swinstall -s /cdrom/product/hpux/SUNWscsd.depot

# swinstall -s /cdrom/product/hpux/SUNWscsu.depot
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▼ To Install Sun StorEdge Diagnostic Reporter

Note – You must install the Sun StorEdge Configuration Service agent before
installing the Sun StorEdge Diagnostic Reporter agent and Config Tool.

Note – Make sure that Java runtime environment software is installed on the remote
login host. The earliest release of Java runtime environment software that is
compatible with Sun StorEdge Diagnostic Reporter is 1.2.2. If you are not using a
remote login host environment, it must be installed on the HP-UX machine on which
you are installing Sun StorEdge Diagnostic Reporter.

1. If you are installing the software from the web site, follow Step 1 through Step 9
in “To Download and Install the Updated Software From the Web Site” on
page 49, and then go to Step 6.

2. If you are installing the software from the CD, make sure that a mounting point
has been created for the CD.

3. Insert the Sun StorEdge 3000 Family Professional Storage Manager CD.

4. Determine the device entry for the CD:

Note the device entry, for example:

5. Mount the CD on your file system if it is not already mounted.

6. If you installed the software from the web site, to install the agent type::

If you installed the software from the CD, to install the agent, type:

# ioscan -fnC disk

/dev/dsk/c2t5d0

# mount -r device-entry mounting-point

# swinstall -s SUNWscsa.depot

# swinstall -s /cdrom/product/hpux/SUNWscsa.depot
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7. If you installed the software from the web site, to install the Config Tool (UI)
type::

If you installed the software from the CD, to install the Config Tool (UI), type:

The agent is installed in /opt/SUNWsscs/ssdiagreporterd. The Config Tool is
installed in /opt/SUNWsscs/ssdiagreporterui.

▼ To Install the Sun StorEdge CLI
The CLI enables you to perform many of the same operations you perform by
choosing menu options from the firmware application or Sun StorEdge
Configuration Service. CLI commands have the advantage of being scriptable, which
is especially useful in large data center environments with many arrays that need to
be configured similarly.

Note – Make sure that a logical drive is mapped to the primary controller.

1. If you are installing the software from the web site, follow Step 1 through Step 9
in “To Download and Install the Updated Software From the Web Site” on
page 49, and then go to Step 6.

2. Make sure that a mounting point has been created for the CD.

3. Insert the Sun StorEdge 3000 Family Professional Storage Manager CD.

4. Determine the device entry for the CD:

Note the device entry, for example:

# swinstall -s SUNWscui.depot

# swinstall -s /cdrom/product/hpux/SUNWscui.depot

# ioscan -fnC disk

/dev/dsk/c2t5d0
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5. Mount the CD on your file system if it is not already mounted.

6. If you installed the software from the web site, type:

If you installed the software from the CD, type:

The CLI is installed in /opt/SUNWsscs/sbin/sccli.

▼ To Display the Console
You cannot start the console until you set the display to show the console.

1. Specify a name for the remote login host and press Return.

If you are not using a remote login host environment, specify the name of the HP-UX
machine:

A terminal window is displayed with the name of the remote login host or HP-UX
machine you specified in the previous step. This is the terminal window from which
you start Sun StorEdge Configuration Service, as described in the Sun StorEdge 3000
Family Configuration Service User’s Guide.

2. Specify the default web browser.

To access online help, Netscape Navigator must be installed on the system on which
you are installing the console. Netscape Navigator is usually installed in either
/opt/netscape/netscape or /usr/bin/netscape.

Note – You can configure the web browser path name at any time; however, if you
do not specify a path name at some point, you cannot access online help.

# mount -r device-entry mounting-point

# swinstall -s SUNWsccli-hpux.depot

# swinstall -s /cdrom/product/hpux/SUNWsccli-hpux.depot

# xterm -display ipaddress of remote login host:0.0 -title name of remote login
host or HP-UX machine
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▼ To Stop or Start the Agents
The Sun StorEdge Configuration Service and Sun StorEdge Diagnostic Reporter
agents can be stopped or started manually.

Note – You must be superuser to start the agent.

If you use start without first using stop, the script restarts any agents that have
stopped. If all the agents have stopped (as with a stop option), the script
reconfigures the runtime environment before restarting the agents.

▼ To Stop or Start the Sun StorEdge Configuration Service
Agent

To stop the Sun StorEdge Configuration Service agent, type:

To start the Sun StorEdge Configuration Service agent, type:

▼ To Stop or Start the Sun StorEdge Diagnostic Reporter
Agent

To stop the Sun StorEdge Diagnostic Reporter agent, type:

To start the Sun StorEdge Diagnostic Reporter agent, type:

▼ To Determine Whether Agents are Running

To determine if the agents are running, type:

# /sbin/init.d/ssagent stop

# /sbin/init.d/ssagent start

# /sbin/init.d/ssdgrptd stop

# /sbin/init.d/ssdgrptd start

# ps -e | grep ss
Chapter 5 Installing the Software on an HP-UX Host 55



Both ssmon and ssserver are displayed in the output if the Sun StorEdge
Configuration Service agent is running. If Sun StorEdge Diagnostic Reporter is
running, ssdgrptd is displayed. If you have enabled SNMP trap generation, you
also see the name sstrapd.

Users and Passwords
The following sections explain how to create users and passwords.

Administrative (User) Security Levels and
Guidelines
If you are running the program on an HP-UX host, administrator security levels are
automatically created during the installation process. You only need to set passwords and
assign users according to the desired permission level.

Administrative functions require access logins and passwords to prevent the
possibility of one administrator reallocating or removing storage resources
belonging to other clients and hosts without authorization.

You assign separate passwords for the three levels of security for the program. You
do this by setting up three users on the agents that have storage devices that are
managed by the program. These three users are automatically added during the
installation of the agent.

The security levels must have these exact names:

■ ssmon

Represents the monitoring level of the software.

■ ssadmin

Represents the administration level of the software and provides access to the
Rebuild, Parity Check, and Schedule Parity Check functions, as well as
monitoring.

■ ssconfig

Represents the configuration level of the software and gives the installer direct
access to the configuration functions and all other related aspects of the program.

These names are required for the three security levels. After installation, you must
assign a password to each security name.
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Note – User passwords are deleted when Sun StorEdge Configuration Service is
uninstalled. If you had a previous configuration, you have to reenter the ssmon,
ssadmin, and ssconfig passwords.

Note – In the event that one of these usernames is already in use, either modify the
existing username, use one of the other Sun StorEdge Configuration Service
usernames, or combine the two roles.

The ssmon, ssadmin, and ssconfig names are logins that correspond only to
security levels within the program. For UNIX operating environments, the default
shell for these accounts is assigned to /bin/false to prevent the user IDs from
being used for interactive logins.

You can set up Sun StorEdge Configuration Service so that monitoring does not
require users to type the ssmon password. To do so, select the Auto Discovery
option when the hosts are added to the Managed Servers list at the console. You can
set up these three logins and passwords locally on each host. (The accounts can have
different passwords on each host, if desired.)

Once you have set up these three logins on the agents to be managed, the system
administrator typically provides user access to the program by assigning employees
appropriate passwords, which are based on the level of security required to
complete tasks. For example, everyone who has administration privileges on a
particular host is assigned the same password that was established for the user
ssadmin.

Note – To add servers to the Managed Servers list, refer to the Sun StorEdge 3000
Family Configuration Service User’s Guide.

▼ To Create Passwords and Permissions
Create a password for each of the new users by typing:

You will be prompted to re-enter the password before receiving confirmation.

Administrators might also want to change group permissions, which are defined in
the svrlist.dat file located in the /opt/SUNWsscs/sscsconsole directory
during installation.

# passwd user-name
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The console is a Java technology-based utility, and as such, cannot provide facilities
to control permissions or ownership of files that Sun StorEdge Configuration Service
creates. The svrlist.dat file is easily readable by various forms of ASCII text
processors. It contains the encrypted password for the user ssmon and can be
decrypted.

Note – Do not change the permissions and group ownership of svrlist.dat after
adding all agents that are being monitored.

Uninstalling the Software
You must uninstall all components of Sun StorEdge Configuration Service when
upgrading to a newer version of the software. Note that some files are not removed
because they are created after the installation and are still valid for the upgrade
environment.

▼ To Uninstall Sun StorEdge Configuration Service
Use the swremove command followed by the package you want to uninstall,
SUNWscsd (agent) or SUNWscsu (console).

▼ To Uninstall Sun StorEdge Diagnostic Reporter
Use the swremove command followed by the package you want to uninstall,
SUNWscsa (agent) or SUNWscui (Config Tool).

# swremove SUNWscsd
# swremove SUNWscsu

# swremove SUNWscsa
# swremove SUNWscui
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▼ To Uninstall the Sun StorEdge CLI
Use the swremove command to uninstall the CLI.

# swremove SUNWsccli
Chapter 5 Installing the Software on an HP-UX Host 59



60 Sun StorEdge 3000 Family 2.5 Software Installation Guide • July 2009



CHAPTER 6

Installing the Software on an IBM
AIX Host

This chapter provides procedures for installing Sun StorEdge Configuration Service,
Sun StorEdge Diagnostic Reporter, and the Sun StorEdge Command-Line Interface
(CLI) on an IBM AIX host. Topics covered in this chapter are as follows:

■ “System Requirements” on page 61
■ “Installing the Software” on page 62
■ “Users and Passwords” on page 70
■ “Uninstalling the Software” on page 72
■ “Troubleshooting” on page 73

System Requirements
This section lists the system requirements for the IBM AIX host.

Note – A web browser is required to view the online help. If you encounter help
display problems, update your browser to a more recent version.If you manage
storage through the web, you will need Firefox 1.x, Netscape 4.79, or Mozilla 2.1, or
later versions of these products. Refer to the Sun StorEdge 3000 Family Configuration
Service User’s Guide for details on web-based management.

■ TCP/IP-compliant network interface – Each console must have a TCP/IP-
compliant network interface (such as an Ethernet or Token Ring network card, or
a serial line with a modem). Each agent must have a TCP/IP-compliant network
interface and driver set (included with the operating system).

■ Color monitor – The console is best viewed with a monitor resolution of 1024 x
768 pixels with 256 colors.
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■ Operating system, memory, and disk space – The following table lists the system
requirements for the IBM AIX operating system.

Installing the Software
Sun StorEdge Configuration Service software includes the following components:

■ Sun StorEdge Configuration Service agent
■ Sun StorEdge Configuration Service console
■ Sun StorEdge Diagnostic Reporter (optional utility)
■ Sun StorEdge CLI

Note – Before installing Sun StorEdge Configuration Service, be sure to read the
release notes for your array.

Note – You must be superuser to install Sun StorEdge Configuration Service and
run the console.

Upgrading Software – Agent and Console Version
Compatibility
Because the communication protocol changes from version to version, you must
install both the agent and console when upgrading. If different versions of the agent
and console co-exist, Sun StorEdge Configuration Service is not able to discover
previously configured arrays.

TABLE 6-1 AIX System Requirements for Sun StorEdge Configuration Service, Sun
StorEdge Diagnostic Reporter, and Sun StorEdge CLI

IBM AIX OS Version Memory Disk Space

5.1, 5.2, and 5.3 256 Mbyte minimum,
512 Mbyte recommended

40 Mbyte minimum,
100 Mbyte recommended
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Installation Packages
The installation packages are contained on the Sun StorEdge 3000 Family
Professional Storage Manager CD, and include the following files:

■ SUNWscsd.bff – Sun StorEdge Configuration Service agent
■ SUNWscsu.bff – Sun StorEdge Configuration Service console
■ SUNWscsa.bff – Sun StorEdge Diagnostic Reporter agent
■ SUNWscui.bff – Sun StorEdge Diagnostic Reporter Config Tool (UI)
■ SUNWsccli.bff – Sun StorEdge CLI

See “To Download and Install the Updated Software From the Web Site” on page 63
for steps on how to download the software from the Sun Download Center web site.

Install the agent on each host that is part of Sun StorEdge Configuration Service.
Install the console on the computer or workstation you plan to use for managing and
maintaining the storage system.

The console can be installed on the host or on any client system. The agent must be
installed on the host to which the storage is attached.

Complete the following steps to install the agent, console, or both. You must install
at least one agent and one console for the program to run.

If you are upgrading, you must install both the agent and console. If different
versions of the agent and console co-exist, Sun StorEdge Configuration Service is not
able to discover previously configured arrays.

Note – Sun StorEdge Configuration Service on IBM AIX supports Sun Java runtime
environment 1.2.2 to 1.5 and IBM Java runtime environment 1.2.2 to 1.4. Make sure
that a compatible version of Java runtime environment is installed on the computer
or workstation on which you are installing Sun StorEdge Configuration Service.

▼ To Download and Install the Updated Software
From the Web Site
If the Sun StorEdge 3000 Family Professional Storage Manager CD is not available,
you can download the software from the Sun Download Center web site.

1. Go to:

http://www.sun.com/software/download/
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2. Under System Administration → Storage Management, click the StorageTek 3000
Family Storage Products - Related Software link.

You are taken to the Sun StorEdge 3000 Family Storage Products - Related Software
page.

3. Click Download.

4. If not previously registered, register.

a. Click the Register Now link at the bottom of the left column.

b. On the registration page, enter applicable data in the required fields and click
Register.

5. Log in.

a. Type your Username and Password in the left column, and click Login.

b. On the Terms of Use page, read the license agreement, click Yes next to Accept,
and click the Continue button.

6. On the software download page, click the link for your array and operating
system.

7. In the dialog box that is displayed, specify a destination directory and save the
file.

8. Change to the directory that the file was downloaded to and unzip the file.

9. Type:

where filename is the name of the file that was downloaded.

10. To install the agent, type:

11. To install the console, type:

After the agent or console is installed successfully, “SUCCESS” is displayed in the
Result column of the Installation Summary.

cd filename /aix

# swinstall -s SUNWscsd.bff

# swinstall -s SUNWscsu.bff
64 Sun StorEdge 3000 Family 2.5 Software Installation Guide • July 2009



12. Specify a path to the default web browser.

To access Sun StorEdge Configuration Service online help, Netscape Navigator must
be installed on the system on which you are installing the console. Versions earlier
than 4.08 are not supported. If a web browser is not detected, you are asked to
specify the path to the web browser.

Netscape Navigator is usually installed in /usr/bin/netscape.

Note – You can configure the web browser path name at any time; however, if you
do not specify a path name at some point, you cannot access online help.

The agent is installed in /usr/SUNWsscs/ssagent. The console is installed in
/usr/SUNWsscs/sscsconsole.

Note – If you know that a supported Java runtime environment is installed but the
installation program cannot find it, see “Troubleshooting” on page 73.

▼ To Install the Sun StorEdge Configuration
Service Agent and Console From the CD

1. If Java runtime environment software is not installed on the computer or
workstation on which you are installing Sun StorEdge Configuration Service,
install it now.

To check the Java runtime environment software version, type:

2. Insert the Sun StorEdge Professional Storage Manager CD and type:

3. To install the agent, type:

# java -version

# mount -v cdrfs -o ro CD-ROM-drive

# installp -a -d /cdrom/product/aix/SUNWscsd.bff
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4. To install the console, type:

After the agent or console is installed successfully, “SUCCESS” is displayed in the
Result column of the Installation Summary.

5. Specify a path to the default web browser.

To access Sun StorEdge Configuration Service online help, Netscape Navigator must
be installed on the system on which you are installing the console. Versions earlier
than 4.08 are not supported. If a web browser is not detected, you are asked to
specify the path to the web browser.

Netscape Navigator is usually installed in /usr/bin/netscape.

Note – You can configure the web browser path name at any time; however, if you
do not specify a path name at some point, you cannot access online help.

The agent is installed in /usr/SUNWsscs/ssagent. The console is installed in
/usr/SUNWsscs/sscsconsole.

Note – If you know that a supported Java runtime environment is installed but the
installation program cannot find it, see “Troubleshooting” on page 73

# installp -a -d /cdrom/product/aix/SUNWscsu.bff
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▼ To Install Sun StorEdge Diagnostic Reporter

Note – You must install the Sun StorEdge Configuration Service agent before
installing the Sun StorEdge Diagnostic Reporter agent and Config Tool.

1. If Java runtime environment software is not installed on the computer or
workstation on which you are installing Sun StorEdge Diagnostic Reporter, install
it now.

To check the Java runtime environment software version, type:

2. If you are installing the software from the web site, follow Step 1 through Step 9
in “To Download and Install the Updated Software From the Web Site” on
page 63, and then go to Step 4.

3. If you are installing the software from the web site, insert the Sun StorEdge
Professional Storage Manager CD and type:

4. If you installed the software from the web site, to install the agent, type:

If you installed the software from the CD, to install the agent, type:

5. If you installed the software from the web site, to install the Config Tool (UI),
type:

If you installed the software from the CD, to install the Config Tool (UI), type:

# java -version

# mount -v cdrfs -o ro CD-drive

# installp -a -d SUNWscsd.bff

# installp -a -d /cdrom/product/aix/SUNWscsd.bff

# installp -a -d SUNWscui.bff

# installp -a -d /cdrom/product/aix/SUNWscui.bff
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After the agent or console is installed successfully, “SUCCESS” is displayed in the
Result column of the Installation Summary.

The agent is installed in /usr/SUNWsscs/ssdiagreporterd. The Config Tool is
installed in /usr/SUNWsscs/ssdiagreporterui.

▼ To Install the Sun StorEdge CLI
The CLI enables you to perform many of the same operations you perform by
choosing menu options from the firmware application or Sun StorEdge
Configuration Service. CLI commands have the advantage of being scriptable, which
is especially useful in large data center environments with many arrays that need to
be configured similarly.

1. If you are installing the software from the web site, follow Step 1 through Step 9
in “To Download and Install the Updated Software From the Web Site” on
page 63, and then go to Step 3.

2. If you are installing the software from the CD, insert the Sun StorEdge
Professional Storage Manager CD, and type:

3. If you installed the software from the web site, type:

If you installed the software from the CD, type:

After the CLI is installed successfully, “SUCCESS” is displayed in the Result
column of the Installation Summary.

The CLI is installed in /usr/SUNWsscs/sbin/sccli.

# mount -v cdrfs -o ro CD-drive

# installp -a -d SUNWsccli-aix.bff

# installp -a -d /cdrom/product/aix/SUNWsccli-aix.bff
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▼ To Stop or Start the Agents
The Sun StorEdge Configuration Service and Sun StorEdge Diagnostic Reporter
agents can be stopped or started manually.

Note – You must be superuser to start the agents.

If you use start without first using stop, the script restarts any agents that have
stopped. If all the agents have stopped (as with a stop option) the script
reconfigures the runtime environment before restarting the daemons.

▼ To Stop or Start the Sun StorEdge Configuration Service
Agent

To stop the Sun StorEdge Configuration Service agent, type:

To start the Sun StorEdge Configuration Service agent, type:

▼ To Stop or Start the Sun StorEdge Diagnostic Reporter
Agent

To stop the Sun StorEdge Diagnostic Reporter agent, type:

To start Sun StorEdge Diagnostic Reporter, type:

▼ To Determine Whether Agents are Running

To determine if the agents are running, type:

# /etc/ssagent.rc stop

# /etc/ssagent.rc start

# /usr/sbin/ssdgrptd stop

# /usr/sbin/ssdgrptd start

# ps -e | grep ss
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Both ssmon and ssserver are displayed in the output if the Sun StorEdge
Configuration Service agent is running. If Sun StorEdge Diagnostic Reporter is
running, ssdgrptd is displayed. If you have enabled SNMP trap generation, you
also see the name sstrapd.

Users and Passwords
The following sections explain how to create users and passwords.

Administrative (User) Security Levels and
Guidelines
If you are running the program on an IBM AIX host, administrator security levels are
automatically created during the installation process. You only need to set passwords and
assign users according to the desired permission level.

Administrative functions require access logins and passwords to prevent the
possibility of one administrator reallocating or removing storage resources
belonging to other clients and hosts without authorization.

You assign separate passwords for the three levels of security for the program. You
do this by setting up three users on the agents that have storage devices that are
managed by the program. These three users are automatically added during the
installation of the agent.

The security levels must have these exact names:

■ ssmon

Represents the monitoring level of the software.

■ ssadmin

Represents the administration level of the software and provides access to the
Rebuild, Parity Check, and Schedule Parity Check functions, as well as
monitoring.

■ ssconfig

Represents the configuration level of the software and gives the installer direct
access to the configuration functions and all other related aspects of the program.

These names are required for the three security levels. After installation, you must
assign a password to each security name.
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Note – User passwords are deleted when Sun StorEdge Configuration Service is
uninstalled. If you had a previous configuration, you have to reenter the ssmon,
ssadmin, and ssconfig passwords.

Note – In the event that one of these usernames is already in use, either modify the
existing username, use one of the other Sun StorEdge Configuration Service
usernames, or combine the two roles.

The ssmon, ssadmin, and ssconfig names are logins that correspond only to
security levels within the program. For UNIX operating environments, the default
shell for these accounts is assigned to /bin/false to prevent the user IDs from
being used for interactive logins.

You can set up Sun StorEdge Configuration Service so that monitoring does not
require users to type the ssmon password. To do so, select the Auto Discovery
option when the hosts are added to the Managed Servers list at the console. You can
set up these three logins and passwords locally on each host. (The accounts can have
different passwords on each host, if desired.)

Once you have set up these three logins on the agents to be managed, the system
administrator typically provides user access to the program by assigning employees
appropriate passwords, which are based on the level of security required to
complete tasks. For example, everyone who has administration privileges on a
particular host is assigned the same password that was established for the user
ssadmin.

Note – To add servers to the Managed Servers list, refer to the Sun StorEdge 3000
Family Configuration Service User’s Guide.

▼ To Create Passwords and Permissions
Create a password for each of the new users by typing:

You will be prompted to re-enter the password before receiving confirmation.

Administrators might also want to change group permissions, which are defined in
the svrlist.dat file located in the /usr/SUNWsscs/sscsconsole directory
during installation.

# passwd user-name
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The console is a Java technology-based utility, and as such, cannot provide facilities
to control permissions or ownership of files that Sun StorEdge Configuration Service
creates. The svrlist.dat file is easily readable by various forms of ASCII text
processors. It contains the encrypted password for the user ssmon and can be
decrypted.

Note – Do not change the permissions and group ownership of svrlist.dat after
adding all agents that are being monitored.

Uninstalling the Software
You must uninstall all components of Sun StorEdge Configuration Service when
upgrading to a newer version of the software. Note that some files are not removed
because they are created after the installation and are still valid for the upgrade
environment.

▼ To Uninstall Sun StorEdge Configuration Service
Use the installp -u command followed by the package you want to uninstall,.
SUNWscsd (agent) or SUNWscsu (console).

▼ To Uninstall Sun StorEdge Diagnostic Reporter
Use the installp -u command followed by the package you want to uninstall,
SUNWscsa (agent) or SUNWscui (Config Tool).

# installp -u SUNWscsd
# installp -u SUNWscsu

# installp -u SUNWscsa
# installp -u SUNWscui
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▼ To Uninstall the Sun StorEdge CLI
Use the installp -u command to uninstall the CLI.

Troubleshooting

Java Runtime Environment 1.4
If IBM Java runtime environment 1.4 is installed on your Linux host, the Sun
StorEdge Configuration Service installation procedure might report that Java is not
installed. This is because Java 1.4 has no rt.jar file in its lib path. If this happens,
perform the following steps.

1. Change to the java_home/lib directory, where java_home is the Java runtime
environment’s home directory.

2. Create an empty file and call it rt.jar.

3. Perform the Configuration Service installation procedure again.

4. If you still get an error, check the Java install path as described in “Java Version
Mismatch” on page 73.

Java Version Mismatch
When installing Sun StorEdge Configuration Service, running java -version
might return a pre 1.2.2 software version even if the machine has Java runtime
environment 1.2.2 or higher installed. If this happens, check that there is a link from
Java runtime environment software to the latest version.

1. Check the /usr directory to confirm there is a link to the latest version of the Java
runtime environment by typing:

# installp -u SUNWsccli

# cd /usr
# ls | grep java
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2. If the link is not to the latest version listed, type:

where xxx is the latest version of the Java runtime environment software.

# rm java
# ln -s /usr/xxx/usr/java
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CHAPTER 7

Installing the Sun StorEdge SMI-S
Provider on a Solaris Host (FC and
SATA Only)

The Sun StorEdge 3510/3511 SMI-S Provider enables Sun StorEdge Enterprise
Storage Manager Advanced Applications Management Software for SE3500 (ESM-
AA) 3.0 and higher to monitor Sun StorEdge 3510 FC and Sun StorEdge 3511 SATA
RAID arrays. This solution requires that you install and configure ESM-AA 4.1, the
WBEM Solutions J WBEM Server (from the ESM-AA 4.1 Accessory CD), Sun
StorEdge Configuration Service version 2.5, and Sun StorEdge 3510/3511 SMI-S
Provider version 2.4.

This chapter provides procedures for installing the Sun StorEdge 3510/3511 SMI-S
Provider. Topics covered in this chapter include:

■ “Prerequisites” on page 76
■ “Preparing for Installation” on page 77
■ “Installing the WSI CIMOM” on page 79
■ “Installing the Sun StorEdge 3510/3511 SMI-S Provider” on page 79
■ “Post-Installation Procedures” on page 80
■ “Stopping and Starting the SMI-S Provider” on page 81
■ “Uninstalling the Sun StorEdge 3510/3511 SMI-S Provider” on page 82
■ “Uninstalling the WSI CIMOM” on page 82
■ “Troubleshooting” on page 83
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Prerequisites
The following components must be installed and configured before installing the
Sun StorEdge 3510/3511 SMI-S Provider:

■ Sun StorEdge Enterprise Storage Manager Advanced Applications 4.1
Management Software for SE3500

■ WSI CIMOM 1.2.2 from the ESM-AA 4.1 Accessory CD
(part number ACC92-200-E9M9)

■ Sun StorageTek Operations Manager 4.1 Patch (Accessory)

■ Sun StorEdge 3000 Family software, version 2.5

■ Java Runtime Environment 1.4.2

▼ To Download the Software From the Web Site
You can download the software from the Sun Download Center web site.

1. Go to:

http://www.sun.com/software/download/

2. Under System Administration → Storage Management, click the StorageTek 3000
Family Storage Products - Related Software link.

You are taken to the Sun StorEdge 3000 Family Storage Products - Related Software
page.

3. Click Download.

4. If not previously registered, register.

a. Click the Register Now link at the bottom of the left column.

b. On the registration page, enter applicable data in the required fields and click
Register.
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5. Log in.

a. Type your Username and Password in the left column, and click Login.

b. On the Terms of Use page, read the license agreement, click Yes next to Accept,
and click the Continue button.

6. On the software download page, click the link for your array and operating
system.

7. In the dialog box that is displayed, specify a destination directory and save the
file.

8. Change to the directory to which the file was downloaded and unzip the file.

9. Type:

where filename is the name of the file that was downloaded and $ARCH is either
sparc or i386, depending on the Solaris OS platform.

Preparing for Installation
Before installing the Sun StorEdge 3510/3511 SMI-S Provider, perform the following
steps:

1. If an older version of the Sun StorEdge 3510/3511 SMI-S Provider is installed,
remove it.

See “Uninstalling the Sun StorEdge 3510/3511 SMI-S Provider” on page 82.

2. If an older version of the WSI CIMOM is installed, remove it.

See “Uninstalling the WSI CIMOM” on page 82.

3. If an older version of the Sun StorEdge 3000 Family software is installed, remove
it.

See “Uninstalling the Software” on page 16.

a. To check which version of Sun StorEdge Configuration Service is currently
installed, perform the following command:

cd filename/solaris/$ARCH

# sccli version
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4. Install Sun StorEdge Configuration Service 2.5.

See “Installing the Software” on page 7.

5. Set passwords for the ssconfig, ssadmin, and ssmon users, if they are not
already set.

See “Users and Passwords” on page 14.

6. To confirm that you are able to manage a Sun StorEdge 3510 FC or Sun StorEdge
3511 SATA array, launch a Sun StorEdge Configuration Service console and log in
using the ssconfig username.

a. To launch a console, enter the following command:

b. To log in as ssconfig, from the File menu, choose Login, select ssconfig
from the Login name drop-list, and enter the password.

7. Set the JAVA_HOME environment variable, if it is not already set.

■ If your login shell is csh, perform the following command:

■ If your login shell is sh, bash, or ksh, perform the following command:

8. Confirm that Java Runtime Environment 1.4.2 or higher is installed.

a. Perform the following command:

# ssconsole

# setenv JAVA_HOME /usr/java

# JAVA_HOME=/usr/java; export JAVA_HOME

# $JAVA_HOME/bin/java -version
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Installing the WSI CIMOM
To install the WSI CIMOM, insert the Sun StorEdge Enterprise Storage Manager
Advanced Applications 4.1 Management Software for SE3500 CD and enter the
following commands:

Note – The Sun StorEdge Enterprise Storage Manager Advanced Applications 4.1
Management Software for SE3500 CD is only available to Enterprise Storage
Manager customers.

Installing the Sun StorEdge 3510/3511
SMI-S Provider
To install the Sun StorEdge 3510/3511 SMI-S Provider, perform the following
commands:

# cd <path_to_ESM-AA_Accessory_CD>
# pkgadd -d . WSIjapi WSIwslib WSIutils WSIjwsrlog WSIjws
# pkgadd -d . WSIjwsdoc WSIjwsmof WSImof WSInpi WSIrmicpa

# cd /cdrom/se3000_sw_2.5/product/solaris/sparc
# pkgadd -d . SUNWagsdk SUNW3x10a
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Post-Installation Procedures
There are several procedures that must be performed following the installation of
the Sun StorEdge 3510/3511 SMI-S Provider. Perform the following steps.

1. Edit the file /opt/SUNW3x10a/config.sh to reflect your local configuration.

The key options which might need modification are:

■ CIMOM_USER – Set this variable to ssconfig or root (other usernames will
not be accepted by the CIMOM for security reasons).

■ CIMOM_PWD – This variable must be changed to the password assigned to the
user account specified by CIMOM_USER.

■ SSCONFIG_PWD – This variable must be changed to the password assigned to
the ssconfig user.

■ AGENT_HOST – If the Sun StorEdge Configuration Service agent that manages
the array resides on a different host, change the AGENT_HOST variable to the
name or IP address of the other host.

Note – The /opt/SUNW3x10a/config.sh file is read by shell scripts used by the
Provider. Changes to the file must follow normal UNIX shell conventions.

2. To verify that your changes have the correct syntax, perform the following
command:

Check for any error messages or incorrect values. (Note that you will see several
additional environment variables which are defined automatically by the ‘bash’
shell. These can be ignored.)

3. Ensure that the config.sh file is protected and cannot be read by users other
than root:

# env - /bin/bash -ac ‘source /opt/SUNW3x10a/config.sh; env’

# cd /opt/SUNW3x10a
# ls -l config.sh
# chown root config.sh
# chmod 0700 config.sh
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4. Complete the installation of the provider by performing the following commands:

Note – Execution of the setup.sh script will take several minutes. Do not interrupt
it. If setup.sh takes more than 15 minutes to complete or displays excessive error
messages, see “Troubleshooting” on page 83.

5. Configure the ESM to discover storage managed by the Sun StorEdge
Configuration Service agent identified in /opt/SUNW3x10a/config.sh.

To discover storage managed by the Sun StorEdge Configuration Service agent, you
must specify the complete URL, including the port number specified by the
HTTPPort variable in /opt/SUNW3x10a/config.sh.

For example, if the provider is running on a host with IP address 10.1.2.3, using the
default HTTPPort value of 25988, you would specify the following URL when the
ESM prompts for the “IP Address/DNS Name” of an element to be discovered:

http://10.1.2.3:25988

Note – If multiple storage devices are managed by the Sun StorEdge Configuration
Service agent running on the host specified in /opt/SUNW3x10a/config.sh, then
all of the storage devices will be discovered together.

Stopping and Starting the SMI-S
Provider
The following commands read the /opt/SUNW3x10a/config.sh file to determine
the correct parameters for starting and stopping the CIMOM. Do not use the
start_server and stop_server commands provided in the WSI package.

To stop the SMI-S provider, perform the following command:

# cd /opt/SUNW3x10a/wbem/mof
# ./setup.sh

# /etc/init.d/se3510_proxy stop
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To start the SMI-S provider, perform the following command:

Uninstalling the Sun StorEdge
3510/3511 SMI-S Provider
To uninstall the Sun StorEdge 3510/3511 SMI-S Provider, perform the following
commands.

Uninstalling the WSI CIMOM
To remove an older version of the WSI CIMOM, perform the following commands:

# /etc/init.d/se3510_proxy start

# pkgrm SUNWagsdk SUNW3x10a
# rm -rf /opt/SUNWagsdk
# rm -rf /opt/SUNW3x10a

# pkgrm WSImof WSIjwsmof WSIjwsdoc
# pkgrm WSInpi WSIrmicpa WSIjws
# pkgrm WSIjwsrlog WSIutils WSIwslib WSIjapi
# rm -rf /opt/wsi
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Troubleshooting
During the execution of the setup.sh script, the following messages might be
displayed. These messages are normal and might occur several times each during
installation.

If the following error message is seen, perform the steps below.

1. Stop the SMI-S provider:

2. Remove entries from the CIMOM database via the following commands:

3. Run the setup script again:

4. If you suspect that the CIMOM database is corrupted, perform the following
steps:

a. Remove the WSI packages by removing the /opt/wsi directory:

WBEMSolutions_ObjectManager.StopService returned 0

/usr/java/bin/java -server -classpath ...

Could not connect to the specified CIM Server

ERROR: tag SE3510-CIM28 exists. setup.sh cannot continue.

# /etc/init.d/se3510_proxy stop

# cd /opt/SUNW3x10a/wbem/mof
# ./unsetup.sh

# ./setup.sh

# rm -r /opt/wsi
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b. If an older version of the Sun StorEdge 3510/3511 SMI-S Provider is installed,
remove it.

See “Uninstalling the Sun StorEdge 3510/3511 SMI-S Provider” on page 82.

c. If an older version of the WSI CIMOM is installed, remove it.

See “Uninstalling the WSI CIMOM” on page 82.

d. Reinstall the WSI CIMOM.

See “Installing the WSI CIMOM” on page 79.

e. Edit the config.sh file to reflect your local configuration.

Perform Step 1through Step 3 in “Post-Installation Procedures” on page 80.

If the ESM does not recognize an array, make sure that the array is manageable via
the Sun StorEdge Configuration Service console. If it is not visible in the Sun
StorEdge Configuration Service console, it will not be accessible to the ESM.

The CIMOM might need to be restarted if it is not running or new arrays are added
which are not recognized by the ESM immediately. To restart the CIMOM, perform
the following commands:

# /etc/init.d/se3510_proxy stop
# /etc/init.d/se3510_proxy start
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